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About Flip PPT Pro 

Often design PowerPoint documents (reports, 

presentations) for business or personal purpose? 

Flip PPT Professional will give you more effective 

and amazing elements to produce consulting 

quality documents. The software Flip PPT Pro is 

helping you to convert PPT presentations into 

Flash based publications, with real page-flipping 

animation and sound. Moreover, you are enabled 

to add many kinds of objects into PPT slides, MP4, 

FLV movies, YouTube videos, MP3 music audios, 

hyperlinks, email addresses, internal page links, 

image slideshow and so on. Bring more interactive 

and wonderful feeling to your presentations! 

 

 

 

 

 

 
 

Note: This product is distributed on a "Try before-you-buy" 

basis. All features described in this documentation are 

enabled. The registered version doesn't insert a watermark in 

your generated page-flipping eBooks. 
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Product features 

1. Convert PPT to Adobe©  Flash® based page-flipping eBooks. 

2. Batch convert multiple PPT files to multiple page-flipping eBooks. 

3. Import hyperlinks with PPT, include web link, page link, email link. 

4. Import text so text is searchable, define the minimum search characters. 

5. Define image or text more, quality and size for pages. 

6. Publish online directly with using FlipBuilder Upload Service. 

7. Build digital bookcase to store and manage eBooks.  

8. Output in different formats: HTML, EXE, Zip, Mac App, Mobile version and Burn 

to CD. 

o HTML allows you to upload to a website to be viewed online (with title, 

keywords and other metadata defined). 

o EXE (with setting title, icon and open window size) and Zip allow you to 

send to your user by email to be viewed on their computer. 

o App (Mac Application) is executable application can be run on Mac. 

o Mobile version is to output HTML flipbook which can be viewed on mobile 

devices via Browsers. 

o Burn to CD allows you to burn to disk so you can send your user physical 

media for viewing on their computer. 

9. Apply a pre-designed template and animated scene, more free templates online. 

10. Preview the output effect instantly. 

11. Show Assistant and scrolling tips in your book, record or embed sound directly. 

12. Add HTML Title in Float template which can be clicked to visit webpage online. 

13. Add Image or Flash logo to insert before Book Title in Float template. 

14. Define book proportions, margin size, shadow manually. 

15. Replace existing icons on toolbar by editing Icon Flash file. 

16. Add new icons into toolbar with calling new actions. 
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17. Set background color and image. 

18. Insert background music either for continuous play (loop) or for a set duration. 

19. Set eBook reading from right to left (for Right-to-Left languages such as Arabic). 

20. Choose hard cover for eBooks. 

21. Set fonts for Flash and Bookmark, Search panel. 

22. Set Page Number Box to show at top or bottom in Float, set start page number. 

23. Edit pages with shapes, text, links, images, videos, flash or sound files.  

24. Add Button on pages to open link page, call Javascript action, play Flash/Video in 

pop-up Window. 

25. Add page, delete page, re-order and sort page in Page Edit window. 

26. Copy projects from one page to another or all the other pages. 

27. Define the language for your published page-flipping eBook (support 

multi-language show and switchable).  

28. Add password to protect your page-flipping eBook. 

29. Different kinds of render engine for choice to avoid distortion for some special 

PPT files: SWF, GPL Ghostscript or Inner Library.  

30. Add Google Analytics Support. 

31. Add watermark image or SWF to show on print out pages. 

32. Add Help config to manually define content with using Image or SWF. 

33. Add Single/Double Page view. 

34. Add Minime Style to show page-flipping eBooks without toolbar. 

35. Set permissions for downloading, printing, social sharing, Home, About button 

and more. 

36. Edit bookmark manually and set bookmark panel to show on left or right side. 

37. Export and save settings for future uses. 

38. Save and Load your project. 
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Page-flipping eBook features 

With the page-flipping ebook you have created, your user will be able to: 

1. Show flip effect on the page corner at the very beginning. 

2. Drag the corner to flip a page. 

3. Click page shadows to flip a page. 

4. Input password to unlock encrypted pages. 

5. Follow the scrolling tips and listen to the audio you recorded for assistant. 

6. Single/Double Page view. 

7. View with pre-loading needed pages to open quickly, do not need to wait all 

pages loaded. 

8. Use button to control page, such as Previous, Next, First, Last etc. 

9. Flip pages automatically. 

10. View flipbook repeatedly. 

11. View page-flipping ebook full screen. 

12. Use thumbnail to navigate. 

13. Search whole eBook. 

14. Print out the whole ebook or a range of pages directly (support to clip area on 

pages and then print). 

15. Download the uploaded page-flipping eBook from web site directly. 

16. Double-click to zoom in or zoom out. 

17. Zoom in/ out both pages. 

18. Share eBook url via email. 

19. Open or close page-turning sound. 

20. Open to a certain page in Browser by adding a suffix like this: 

index.html?pageIndex=4. 

21. View output page-flipping eBook on iPad, iPhone and Android devices (slide 

single pages mode supported). 
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Quick Start 

1. Launch the application via the desktop shortcut ; 

2. Click "Create New" and select template and define 

project path; 

3. Select PDF to import and click "Import Now" icon  to 

enter into template setting interface; 

4. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

then click the "Apply Change" icon ; 

5. Click "Edit Pages" to add objects like links, images, sounds, videos on 

pages; 

6. Click "Upload Online"  or "Convert to Flipping Book"  

to output created page-flipping eBook. 

Interfaces 

There are some main interfaces you will see while using Flip PPT Pro as 

below shows: Project Panel, Application Options, Import PPT, Template 

Settings, Edit Pages, Language Option, Output, Batch Convert and 

Upload Online. You can enter into each page to get clear instructions for 

every detail option. 
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I. Project Panel 

 
In the project control panel, you can view and open recent projects and output flipbooks, create 

new project or just view demo project. Besides, you can view Online Service details, get support, 

check "About" and "Update" info. 

 

II. Import PPT Interface 

Chick "Create New" to build your own project, select template, define project name and location. 
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You can select Template and Theme from the list, or go to "Online Templates" panel to download 

more templates and themes to use in Flip PPT Pro. More templates and themes online: 

http://www.flipbuilder.com/templates-themes/index.html . 

 

Then click "Next" to enter into PPT Import interface: 

 

1. Source PPT File:  

 Click this icon to open the PPT file you want to convert; 

 View content of added PPT file to clarify before converting. 

2. The Page Ranges to Import: 

 Convert all pages to page-flipping eBook; 

Convert defined range page; 

 Just preview effect on first 10 pages. 

3. File Mode 

 

http://www.flipbuilder.com/templates-themes/index.html
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4. Page Quality 

There are five types of "Quality And Size": 

 

5. Other Options: 

If your PPT file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

 

At last, click  icon to enter into template setting interface. 

 

III. Template Settings Interface 

 
After importing PPT, you will see the main Template Design and Preview interface. Four tabs 

in the design panel for you to design template, choose scene, define bookmark and edit 

content for assistant.  
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1. Design Setting 

The design setting interface contains below main parts: Choose Template, Tool Bars 

Settings, Flash Display Settings and Flash Control Settings. 

 

(1). Choose Template 

 
Although you have selected template before importing PDF, you can also change to other 

templates. Just click  icon to select templates from Template Selection 

interface, or download Online Templates to use. 

Click this icon is to save current settings as a TXT file for later uses; 

Click this icon is to import stored setting file at once. 

There are 4 different templates at present: Classical, Float, Neat and Spread. You can also click 

"Online Templates" to install more templates to use. Each template contains some unique 

settings. More templates and themes online: 

http://www.flipbuilder.com/templates-themes/index.html . 

 

(2). Tool Bar Settings 

 

i. Title Bar (only in Float template) 

 

http://www.flipbuilder.com/templates-themes/index.html
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Customize book title and logo for showing on the top of your flipbook. You are enabled to 

set the book title as HTML format text. For example: <a href='http://www.flipbuilder.com' 

target='_blank'>FLIPBUILDER.COM</a> | <font color='#ff0000' size='14'>Red Color</font> 

ii. Buttons Bar 

 
 

Home Button 

You can add a home button  to help reader to click and go to your website directly: 

 

About Button 

Add About button  to show the author, contact, book, company info: 

 

Click "…" to enter into "About & Contact" edit interface, after clicking the About button, you will 

view the About window by clicking the button: 
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Full Screen Button 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

Button" option:  

Then you can click icon  to view flipbook in Full Screen, click icon  or "Esc" 

button to exit from the Full Screen. Or if you want to show your flipbook without Tool Bar 

while showing in Full Screen mode, you can set "No" in "Full Screen without Tool Bar" (just in 

Classical Template):  

 

Help Config 

 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you 

can define Help Content manually by inserting "Help Content File (image or SWF)", also 

enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the 

book to center->No", you can set "Show Help At First->Show" to display the Help Panel with 

the Book as below: 

 

You can also click the button  to view the same Help page in pop-up window. 

 

Print Config 

 

Choose "Yes" in "Print Enable", You can also click "Print Watermark File->…" button to 

choose image or SWF file from your computer as watermark on printed out pages. Then 

users can click icon  to set print page range as below: 
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Download Setting 

  

If you want your flipbook readers to download the PPT file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 

you can use absolute path like 

"http://www.flipbuilder.com/flip-ppt/example/files/download/demo.ppt" or relative path 

like "/files/download/demo.ppt " (make sure you have uploaded the PPT to the same path). 

Then readers can click the icon  to download your uploaded PPT file directly. 

Sound 

 

If you want to add background sound to your flipbook, such as a song or other audio file, set 

"Enable Sound->Enable", then click " " icon to choose "Sound File" from your computer, 

then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing 

flipbook, other value (N>0) stands for the times of playing the sound file. 

Zoom Config 

 
To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current page size. 
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In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by 

the zoom in tool like this: . You can also set "Scroll with 

mouse->Yes" to scroll zoom in page while moving mouse. 

 

Search 

 
Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

"Import PPT" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search" button, 

you will get the below searching result: 

 

 

Share 

 
You can share via emails, or just through Facebook, Twitter, Google, etc.. 

a. Share Button 

If you want readers to share via Email, you can enable "Share" feature as below shows: 

 

When the viewers click the share button , they will enter into the Email interface with 

the link of your flipbook in the Email body. 

b. Social Share 

If you want your flipbook viewers to send the link to their friends or clients via Facebook, 

Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your 

flipbook for readers to send out your flipbook link immediately: 

 

The readers just need to click the "Social Share" button , then the below window will pop 

up for them to choose share channel: 
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Auto Flip 

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the 

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip 

button , the flipbooks will be flipped by staying 3 seconds per page); if you want to 

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes": 

 

 

Thumbnail Button 

 

Show Thumbnail Button (set "Enable") to view page thumbnails of your book, or you can 

Disable it to hide the button. 

 

Single Page 

 

If your book contains landscape pages, or the page content is different to read for the font is too 

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon  to 

view pages one after another, then click "Double Page" icon  to back to the normal book 

reading mode. 

 

Language 
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You can set language for showing tools or tips in your created flipbook, click "…" to enter into 

"Language Settings" interface. You can choose two or more language to use, just check 

"Switchable" option, then users can click "Switch Language" button to choose their prefer 

language for tips: 

 
 

Add Annotations 

To help readers take notes on your books while reading, you can set "Add Annotation->Enable". 

When readers view your book on computer, they can click "Add Annotation" icon  to add 

text note, highlight pages with brush, draw rectangle or ellipse on anywhere of your book pages. 

If they open the book next time, they can view the comments, or delete as they want: 

 

 

iii. Tool Bar on Top (only in Float template) 

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 

"Tool Bar on Top" as "True": 
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iv. Add Icons Settings 

If you want to add some other kinds of buttons which the program doesn't provide, you can click 

"Add Icons Settings->…" to enter into "Icons Settings" interface to add new icons on tool bar: 

 

You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More 

details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".) 

 

v. Button Icons 

Define settings for the icons of the buttons: 

 

Icon Color  
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Icon File 

Select the Tool Bar Button to replace with your own icon.  

 

More details please view here:  

http://www.flipbuilder.com/support/how-to-replace-icons-on-flash-toolbar.htm 

 

(3). Flash Display Settings 

 

i. Retain the book to center 

 
If you select "No" in this option, the eBook will be shown on the right-side. This setting is for 

embedding special background image, such as advertisement or company log. 

 

ii. Pages per thickness (only in Neat template) 

To create more real life like ebook, you can set Pages thickness, there are 5 levels for you to 

choose based on your needs. And on the book edge, you will see different page number tips for 

you to click and go to that page directly: 

 

 

iii. Background Alpha 

 

http://www.flipbuilder.com/support/how-to-replace-icons-on-flash-toolbar.htm
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Set the value (0-1) of alpha to control the transparence of the background in flip book. For 

example, you can set the value as 0 to make the book background as transparent completely, 

when you embed the book in other HTML page, it will show the background of that HTML only. 

iv. Show Corner Flip Effect 

Show the Corner Flip Effect at the beginning to tell readers that they can drag or click the corner 

to turn pages directly. 

 

v. Mouse Tracing Effect 

Show Mouse Tracing Effect at the beginning to tell readers that they can drag or click the corner 

to turn page. If the book is set to open with double page spread, then the Mouse Tracing Effect 

won't work. 

 

vi. Open thumbnails pallet 

Define whether the thumbnail pallet open or not when you arrive on the book. 
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vii. Font 

 

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search 

result panel, you can set font types and colors in Font Panel.  

 

viii. Initial Show (set in Float/ Spread templates) 

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in this option: 

For Example, select "Thumbnails":  

Then you will get flipbook shown with below initial interface: 

 
 

ix. Background Config 

Background Color:  

 

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors. 
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Background Image (set in Classical and Spread templates): 

 

Click the icon " " to choose background image from your computer, and there are 11 kinds 

of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  

Background Image (set in Float template): 

 
The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to 

choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

Right, Bottom Left, Bottom Center and Bottom Right. 

 

x. Flash Window Color 

 

This color will be applied on all flash windows, such as the book window, "Help" window, 

"Print" window and so on. 
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xi. Page Background Color 

 

When load pages, or if the page number of your PPT file is odd, then the page (the last page) 

will show with the "Page Background Color". 

 

xii. Book Proportions 

 
Please note that the values are not fixed in pixels or inches, they just represent a ratio for 

"Page Width: Page Height", and the book size will be changed depend on your Explorer 

Window Size. 

 

xiii. Book Margins 

Book Margin (set in Classical Template): 

 

"Book Margin" refers to the distance between the book and the toolbar. 
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Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template): 

 

 

xiv. Page Shadow 

 

The value also takes the value of Book Proportions as reference, and the value interval of 

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color. 

 

xv. Hide Book Frame Bar 

 

If don’t want to show the book frame bar, choose “Yes” in this option. 

 

xvi. Right to Left 

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in 

"Right to Left" option: 
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xvii. Start on Double Page 

Open your book in double-page spread or not. "Yes" means open book without cover, presenting 

first two pages at a time. If you have odd number pages, you can set this option as "Yes". 

 

xviii. Hard Cover 

If you want create hard cover effect (a book bound with rigid protective covers) for your 

flipbook, choose "Yes" in "Hard Cover" option: 

 

xix. Flipping time 

 
Sets page flipping time in seconds according to your needs. (Recommended value is 0.6) 

 

xx. Mouse Wheel to Turn page 

 
Enable or Disable turning page with mouse wheel. 

 

xxi. Page Number 

If you don't want to count in the cover page, table of contents pages into the actual page 

numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". 

For example, the first 3 pages are Table of Content pages with Roman page numbers, and 

set Arabic page numbers from page 4, then you will get page number box like below: 
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xxii. Minime Style 

If you want to present Page-flipping eBook pages directly without showing toolbar, especially 

when you want to embed eBook into a small area in existing webpages, then you can use this 

"Minime Style". The Minime Style will trigger when the Width or Height of the Flash Container is 

less than the defined value. You can also always show the page-flipping eBook in Minime Style 

with adding a parameter to your URL like this: 

www.yourdomain.com/index.html?alwaysMinimeStyle=true . 

 

 

(4). Flash Control Settings 

 

 

i. Security Settings 

 

If you want to protect your flash books with passwords, you can click "…" icon to enter into 

"Flash Security Config" interface: 
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Select "Security Type->Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as "All 

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 

permission.) 

 

ii. Links 

 
If you have check "Import links" option in "Import PPT" interface, or add links in "Edit Page" 

interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers 

to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), 

and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting 

"Enable after Zooming in->Enable". 

 

iii. Google Analytics  

In the HTML output format, you can add statistics by using google analytics. You can get 

more information about Google Analytics ID from http://www.google.com/analytics/ . 

 

2. Scenes Setting 

To make your book more attractive and lively, you can apply animated "Scene" in the flip 

program. There are many pre-designed scenes for you to use directly, such as Autumn 

Leaves, Beach Beauty, Desert, Moon, Underwater World, Grassland, Snow, Clouds, etc. 

 

http://www.google.com/analytics/
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Just double-click to apply the scenes, or you can set your own style scene by setting "SWF" 

format background image in "Design Setting" part. 

 

3. Bookmark Editing 

You can edit bookmarks in the program. In Classical Template, you can even define 

bookmark font color, background color, position, etc.: 

 

 

4. Assistant 
If you want to provide sound or text tips for pages of your books, you can enable the Assistant 

Feature, edit scrolling text, record audio or insert sound directly. Then readers can follow your 

tips, listen to the audio you applied, get more interest and info from your book. 

 
 

Click "Record & Manage Audio Files" icon to Record Audio: 
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Input "Audio Text" for each page, and then choose Text-to-Speech engine, and then click 

"Generate audio". After generating, you can click "Play audio" to listen to the audio, you can 

also choose "Import audio from existing file" to apply existing audio directly. About 

Text-to-Speech engine install and use, you can view details in this page: 

http://www.flipbuilder.com/support/how-to-read-your-text-to-readers-in-flipping-book.htm  

 

5. Other Settings 

(1). Export Theme 

If you want to save the current template settings as your own style template for later uses, you 

can click "File->Export current settings as Theme" button to storing all current template settings, 

include the background images, margin values, toolbar buttons and so on. 

Then when you want to use later, just click "File->Import Themes", the theme will be added to 

the templates selecting interface. Download more themes from FlipBuilder now: 

http://www.flipbuilder.com/templates-themes/index.html . 

 

(2). Application Options 

Pages Quality and Size for mobile version 

 

Mobile Template 

The current version provides two mobile template modes for you to use: Slide and Single Page 

Flip. The later one adds page-flipping effect on the pages while viewing in mobiles. 

After defining options, click "Apply Change" icon  to apply the settings. 

http://www.flipbuilder.com/support/how-to-read-your-text-to-readers-in-flipping-book.htm
http://www.flipbuilder.com/templates-themes/index.html
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IV. Edit Pages 

Use Flip PPT Pro to edit imported pages directly, no matter you want to add link, video, sound or 

image file. Click "Edit Pages" button  to enter into page edit interface: 

 

 

1. Add Link 

Click the icon  and then draw a link box on the area you want to add link, then define 

properties in below panel: 
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You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself. For example, you can show a pop-up light box while readers clicking some 

image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make 

sure the parameter you set in "Function" can be called in from HTML page. 

 

Example: Check "Call Javascript function" as action type, then input Function as 

"testLightBox("Hello, this is a test"): 

 

And then make sure the Javascript wrote into the index.html page as below image shows (the 

same as you set in "Link Function"): 
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2. Select Shape to Insert 

You can draw shapes on pages as you want by clicking icon . You can add below shapes: 

(1). Line 

Choose "Add Line" icon  to draw line on pages, and then define options for the inserted line 

in right panel as you want. Like set Line Type as "Solid line" or "Dotted line", define Line Color, 

Width, Alpha, Position, Size, Shadow, and Effect (support "Fade In" at present): 

 

(2). Add Arrow-line 

Click "Add Arrow-line" icon to draw arrow-line on pages. You can also define the arrow-line 

proportions, like color, width, alpha, position, size, etc.: 

 

(3). Add Ellipse 

Click "Add Ellipse" icon  to draw ellipse on pages, you can also define options like actions, 
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fill style, color, border, shadow, effect, etc. Action types include "Go to page", "Open a link", "Call 

Javascript function", "Open Flash /video Window", "Play Audio" or "Photo Slideshow". 

 

(4). Add Rectangle 

Click "Add Rectangle" icon to draw rectangle on pages, you can also define options like 

actions as "Go to page", "Open a link", "Call Javascript function", "Open Flash /video Window", 

"Play Audio" or "Photo Slideshow". And define fill style, color, border, shadow, effect, etc: 
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(5). Add Highlight Area 

Click "Add Highlight Area" icon  to draw highlight on pages, you can also define options like 

actions as "Go to page", "Open a link", "Call Javascript function", "Open Flash /video Window", 

"Play Audio" or "Photo Slideshow". And define color, round rectangle, etc: 

 
 

3. Add Text 

You can edit different types text by clicking icon : 

(1). Add Plain Text 

Click "Add Plain Text"  to insert text into pages, then edit text content in right edit panel, you 

can also define actions, font, color, background, effect, etc. 
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(2). Add Callout 

Add callout text like dialog box, just click "Add Callout" icon , input text and define actions: 

 

(3). Add Animated Text 

You can add text with different kinds of animated effect, such as Letter Spacing, Scale Word, Right 

To Left, Center to Edges, etc. Just click "Add Text Anim" icon to add text and choose effect: 
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(4). Add Dynamic Text 

To have your text scroll up a slide like the credits after films, just click "Add Dynamic Text" icon 

 to add text and choose action: 

 

(5). Add Star Words Text 

To make your text more different, you can click "Add Star Words Text" icon to show text as 

below shows: 
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(6). Add Effect Text 

To show text characters one after another, just click "Add Effect Text" icon , input your text 

and choose style, font and define actions: 

 
 

4. Add Movie 

Click icon  and then draw a box like below on the page you want to insert FLV movie. Then 

you can select and edit the movie in below panel (define video player skin color, preview image, 

play and stop movie actions, etc.): 
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5. Select Image Displayer to Insert 

(1). Add Image 

Click the icon  to draw image box and then select image (.jpg, .png, .bmp, .gif), set Action 

Options (the same as Link Action Options), you can also set "Make it zoom when mouse over or 

out" or "Add border when mouse over", and set Effect as "Fade In" or not: 

 

 

(2). Add Embedded Slideshow 

Click the icon "Add Embedded Slideshow"  to show your images as slideshow. The images 

are displayed one at a time and pan from one point to another. Suitable for photography 

slideshow for wedding, presentation, etc.. : 

 



PPT to Professional Page-Flipping eBook Utility 
User Document 

Copyright 2012 by FlipBuilder.com 
- 37 - 

 

(3). Add Clipart 

You can add clipart on pages to decorate pages of your book by clicking "Add Clipart" , and 

there are multiple PNG format cliparts for you to add on pages directly, such as computer, animal, 

dialogue, characters: 

 

(4). Add Banner 

You can add banner image with page flip flash effect by clicking "Add Banner" , then choose 

image and you can preview the banner effect directly: 

 

 

6. Add Sound 

You can add different sound players by clicking icon "Select Sound Player to Insert" . You can 

choose Player Skin for all kinds of sound player, set skin color, when to play or stop the sound: 
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(1). Add Normal Sound Player 

Click the icon  to draw sound box and then select sound file: 

 

(2). Add Advanced Sound Player 

There are also different skins for you to choose by clicking "Add Advance Sound Player" , 

more functional and different style: 

 

(3). Add Wave Music Player 

To show your music with wave, click "Add WaveMusicPlayer"  and select music then: 

 

 

8. Add Flash 

Click icon  to insert SWF flash into your defined area of flipbook page, there are different 

types of SWF files provided for you to use directly, such as tree, birds, cloud, butterfly, etc.: 
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9. Add Button 

Click icon  to draw an area for inserting your image or SWF button file with calling actions. 

The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash 

Window". The before three actions are the same with the actions in "Add Link", the "Open Flash 

Window" can help you to play SWF Flash or FLV Video in the pop-up window: 

 

 

10. Add You Tube Video 

Click the icon and then draw a box on the page to insert You Tube video into pages directly. 

You just need to define the video ID directly. For example the video link is: 
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http://www.youtube.com/watch?v=xKA6WIqjB7c, then the video ID is "xKA6WIqjB7c".  

 

 

11. Add Printable Area 
If you want readers can click on some 

area of your book to print the area 

directly, such as coupons which can be 

used to buy your presented goods, 

you can add a "Printable Area" on 

pages by clicking the icon , and 

then draw the area on the pages, set 

title and description: 

 

 

12. Copy and Paste  

If you want to add same links, images, videos, audios to different pages, you don't have to repeat 

the "Link/Image/Video/Audio added" operations once and once again, just select the link object, 

click the copy button and then go to the other page to click the paste button directly. 

13. Apply All 
If you want to use the same link, video, audio, image 

or button on all pages (or all odd, even pages, or your 

customized pages), you can select the object and 

then click the Apply All button , then define the 

apply page range in pop-up window: 
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14. Add/ Delete/ Reorder Pages 
If you want to add more pages to your existing 

project, or delete some page, or change the 

order of pages, you can click the buttons on the 

left panel box to add (JPG, PNG or SWF), delete 

or reorder: 

 

 

After adding links, flash, movie or sounds, 

you can click the icon  to save the 

settings and back to the template setting 

interface. 

 

V. Language Options Interface 

Click "Option->Flash Language" or "…" button beside Language setting part, you will enter into 

the Language Settings interface as below shows: 

 

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you 10 different languages for you to use: 

English, Chinese, Arabic, French, German, Greek, Hebrew, Italian, Japanese and Portuguese.  

You can also add other language for your own uses: 
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1. Click the button  and define name for the new language: 

 

Click "OK" to save the new language in the list; 

 

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, 

then click "Save And Edit Next": 

 
 

 

3. At last, you can get all Labels translated into your new language as the images shows: 

 

You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  



PPT to Professional Page-Flipping eBook Utility 
User Document 

Copyright 2012 by FlipBuilder.com 
- 43 - 

 

VI. Upload Online 

To make it easier for you to publish your created flip page books online, we developed the 

Upload Online Service. By using this service, you can upload your book online instantly after 

creating it, with no FTP or other upload tool needed. You can easily manage your books, and 

make it easy for people to view your books online in their browser on their PC, Mac, iPhone, iPad 

and Android devices. 

After designing your book style, just click "Upload Online" button to upload 

your book onto FlipBuilder website server directly. Just need 3 steps: Sign up, login your account, 

upload your book. 

1. Sign Up 
Create your account to use the Upload Service easily: 

 

2. Login Account 

After registration successful, you will login automatically.  

3. Upload Your Book 

After login your account, just input your book HTML title and then click "Publish Now" to 

upload your book. You can also define Description and create mobile version in "More": 

 

After uploading successfully, you can use the Book URL to share with others online, or 

through social share websites, or copy the Embed Code to insert into webpages in "Book 

Information" panel, etc. 
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You can click "Manage Online Books" button in main process interface 

to manage your uploaded in below window: 

In the book manage window, you can check your publications, share them with others, edit 

book info, hide your book to prevent other people from reading your book, even delete it if 

you want to edit again. 

 

You will get 5 free points after registering, and a point can be used to upload a book within a 

month. You can purchase more points to use based on your needs, and more points 

purchase at a time, you can get order with more discount. 

 

Within 24 hours of the first start service for each book will not charge, and a point will be 

deducted after the 24 hours. If you delete or disable the book within the month, the service 

center will stop charging you in later months, or if you enable the book again in the same 

month, you won't be charged again. Should be noted that, if you disable the books within 
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the first 24 hours, the system won't charge, but if you enable the books in the period after 

this 24 hours, the system will immediately charge points. And once your surplus points are 

not enough to pay for all books service, the system will enable related number of books, but 

disabled the other ones. 

 

There is another charge method if you have dozens of even hundreds of books to upload a 

month, monthly charge $9.99 to upload 1000 books a month. You can transfer to VIP User to 

pay monthly in the "Account Info" panel of online manage page: 

http://panel.flipbuilder.com/userLoad/accountInfo.php . 

 

More FAQs about Upload Service: http://panel.flipbuilder.com/userLoad/faq.php  

 

VII. BookCase 

BookCase integrated in Flip PPT Pro will be the best tool to help you build digital library to 

store and manage eBooks. All books you published on FlipBuilder Server can be collected and 

shown in your bookcase automatically, you can easy manage and share the books via using 

the wonderful and realistic BookCase tool. 

1. Create BookCase 

i. Click "BookCase" button 

Click  in Flip PDF: 

i. If you don't have account in FlipBuilder Server, "Create New Account", just input your Email and 

Password, and then you will login automatically; 

ii. If you have built account in FlipBuilder Server, just login with your Email and Password, click 

"Login". 

http://panel.flipbuilder.com/userLoad/accountInfo.php
http://panel.flipbuilder.com/userLoad/faq.php
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ii. You will enter into BookCase Build interface after login: 

 

iii. Click "Create Now" to define your Link Name:  

The Link Name will be shown in your BookCase link (the name can't be modified once creating): 
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iv. Create BookCase Finish! 

 

2. Design BookCase 

 
You can set Tool Bar Settings, Book Settings and BookCase Display Settings. You can also use 

Scenes to be the background of your BookCase, or build Photo Gallery for your BookCase. 
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i. Tool Bar Settings 

 

(1). Title Bar 

Customize book logo for showing on the top of your BookCase, you can also add link on the logo 

for viewers to click and visit your webpage directly: 

 

(2). Sound  

You can set background sound for your BookCase, choose MP3 file, and set Sound Loops ("-1" 

stands for playing the sound file all the time while viewing BookCase), check "Enable" at last. 

 

 

(3). Share  

If you want readers to share via Email, Facebook, Twitter, you can show "Share", and set "Share 

Page Info" to show on the window of share: 



PPT to Professional Page-Flipping eBook Utility 
User Document 

Copyright 2012 by FlipBuilder.com 
- 49 - 

 

 

 

(4). Contact Us 

Enable your BookCase viewers easy know more info about your company and contact you with 

simple clicks, just input your information in "Contact Us" setting options, like Company Picture, 

Company Description, Company Name, Company Address, Company Website, Email, Skype, 

Yahoo, et.. 

 

(5). Full Screen 

Enable "Full Screen" functionality in BookCase, just select "Show" in "Show Full Screen" option: 

 

 

(6). Help 

To show tips about viewing BookCase, you can set "Show" in "Show HelpButton" option: 



PPT to Professional Page-Flipping eBook Utility 
User Document 

Copyright 2012 by FlipBuilder.com 
- 50 - 

 

 

 

ii. Book Settings 

 

 

Book Space: You can set "Book Space" value to define the distance of two books on your 

BookCase, the max value is 1, the min value is 0.25. 

 

Open new Window: Set "Open new Window" as "True", then when viewers visit your BookCase 

online, they can open your book in a new window instead of opening in the current window. 

 

Show Book Shadow: You can also set "Show Book Shadow" as "True" to make your BookCase 

look more realistic. 

iii. BookCase Display Settings 

 

 

(1). Bar Settings 

You can set BookCase Button Color, Title Color and Search Result Title Color. 
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(2). Show Images 

Show photo gallery in your BookCase, just set "Show Images->True", and then import images and 

define Title and Summary for these images. Then click the "Photo Gallery" icon on toolbar to 

view images in BookCase, you can also click image to view slideshow: 

 

(3). Search Setting 

 

Viewers can search book while viewing, and you can set the least number of search characters. 

 

(4). BookCase Shadow 

 

You can set the shadow of your BookCase show or not. 
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(5). Background Config 

Background Color 

 

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors. 

Background Image 

Click the icon " " to choose background image from your computer, and there are 11 kinds of 

"Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, 

Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  

 

 

Background Alpha 

 

Set the value (0-1) of alpha to control the transparence of the background of BookCase. For 

example, you can set the value as 0 to make the BookCase background as transparent completely, 

when you embed the BookCase in other HTML page, it will show background of that HTML only. 

 

iv. Scenes  

To make your BookCase more attractive and lively, you can apply animated background which 

called "Scene" in the BookCase setting interface. There are many pre-designed scenes for you to 
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choose and use directly, such as Autumn Leaves, Beach Beauty, Desert, Moon, Underwater 

World, Grassland, Snow, Clouds, etc. 

 

Double-click to apply the scenes, or you can set your own style scene by setting "SWF" format 

background image in "Design Setting" part. 

 

3. Upload Online 

After designing your BookCase style, you can click "Upload Online" button to 

upload your BookCase onto FlipBuilder website server directly. Define "Title" and "Description" 

and then click "Upload" to publish: 

 
After uploading successfully, you can click "Share" to share your BookCase with others via email, 

or through social share websites, or copy the Embed Code to insert into other webpages. 
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VIII. Output Interface 
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1. HTML 

 

This output type is for uploading created page-flipping ebook onto websites: 

 

You can define HTML Title and other properties by clicking "Advanced" button:  

 

  
 

Set Keywords, Description or even Script in the below interface: 

 
 

2. ZIP 

 
 

This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon:  

 

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

flipbook instantly: 
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3. EXE 

 

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:  

 
You can also define Icon and Opening Window Size in Advanced Settings: 

 

 

4. APP 

 

If you want to make executable application to run on Mac devices, you can output as 

"*.app" format. 

 

5. Mobile Version 

 

You can even output Mobile Version while choosing HTML or ZIP format at the same time. 

And you can set Mobile Version quality and template in "Options->Application Options". 

 

6. Burn to CD 

 
After choosing output type, then check the option "Burn to CD", set "CD Writer", define 

"Disc title". 
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How to make created eBooks available for others online, more details this support page: 

http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.htm . 

 

At last click button to output flipbook in your defined type. 

 

IX. Batch Convert Interface 

 

1. Add PPT Documents 

Click this icon to add PPT files from computer; 

 Click this icon to add all PPT files in the folder (include sub-folders). 

You can also remove some unwanted PPT, move up/ down files, or clear all documents.  
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2. Settings 

(1). Output Settings 

  i. Choose Output Type 

 

  ii. Choose Output Path 

 

 
 

You can also define output name pattern with FileName, Title, Subject and so on: 

 
 

And after defining the File Name, you can preview the result example below: 

 

 

  iii. Define Output Option 

 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks: 
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(2). PPT Settings 

  i. Page Range 

 

 

You can convert "All pages" or just "Custom range"; 

  ii. File Mode 

 

  iii. Page Quality 

 

Choose quality and size type from listed five kinds. 

  iv. Other Options 

If your PPT file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

 

At last, click  icon to batch convert listed files together. 
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License Agreements   

 

All copyrights to Flip PPT Pro (the Software) are exclusively owned by FlipBuilder.com. For 

more information, visit our website at www.Flipbuilder.com . 

 

Anyone may use this software but all the page-flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  

 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by A-PPT Solution. 

 

Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product. 

  

 

http://www.flipbuilder.com/
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How to Order 

 

Order Online (http://www.flipbuilder.com/flip-ppt-pro/index.html) or Order Toll Free 

1-877-353-7297 (When you order toll free just give the operator the product number of the 

product you would like). 

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now] 

 

2. Select the currency that you want to use. (You can also continue shopping) 

 

3. Fill billing information and select a payment method. (Your information is safe with us) 

 

4. Check the information you filled previously and click "Place Secure Order"  

 

Other Order Ways—With Phone/Mail/Fax/Check: 

 

If you are not comfortable ordering online with a credit card, you are welcome to choose an 

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

International Callers.  

 

Please note that all of the offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

browser to send your payment to us offline. 

 

100% unconditional 30 Day Money Back Guarantee 

 

 

Want to custom the program or have other questions about purchase? 

Contact us at support@flipbuilder.com . 

 

 

 

mailto:support@flipbuilder.com


PPT to Professional Page-Flipping eBook Utility 
User Document 

Copyright 2012 by FlipBuilder.com 
- 62 - 

 

Support 

You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you are not satisfy with the solutions 

provided, please contact support team for help. 

 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: 

http://www.flipbuilder.com/support 

 

2. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 

obtain the invoice.  

 

3. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 

support@flipbuilder.com, we will respond you ASAP. 

 

 

 

http://www.regnow.com/cs/orderStatus
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http://flipbuilder.com  

http://flipbuilder.com/

